
FF ir aair PPl  laayy CCooddee    
                      ... for COACHES 

 
 

 I will be reasonable when scheduling games and practices, 
remembering that players have other interests and obligations. 

 
 I will teach my players to play fairly and to respect the rules, officials 
and opponents. 

 
 I will ensure that all players get equal instruction, support and playing 
time. 

 
 I will not ridicule or yell at my players for making mistakes or for 
performing poorly. 

 
 I will remember that players play to have fun and must be encouraged 
to have confidence in themselves. 

 
 I will make sure that equipment and facilities are safe and match the 
players’ ages and abilities. 

 
 I will remember that participants need a coach they can respect. I will 
be generous with praise and set a good example. 

 
 I will obtain proper training and continue to upgrade my coaching 
skills. 

 
 I will work in cooperation with officials for the benefit of the game. 

 
 
 
Parent’s Signature:  Date:  
 



FF ir aair PPl  laayy CCooddee    
                      ... for PARENTS 

 
 

 I will not force my child to participate in hockey. 
 

 I will remember that my child plays hockey for his or her enjoyment, 
not mine. 

 
 I will encourage my child to play by the rules and to resolve conflicts 

without resorting to hostility or violence. 
 

 I will teach my child that doing one’s best is as important as winning, 
so that my child will never feel defeated by the outcome of a game / 
event.  

 
 I will make my child feel like a winner every time by offering praise 

for competing fairly and trying hard. 
 

 I will never ridicule or yell at my child for making a mistake or losing 
a competition. 

 
 I will remember that children learn best by example.  I will applaud 

good plays / performances by both my child’s team and their 
opponents. 

 
 I will never question the official’s judgement or honesty in public. 

 
 I will support all efforts to remove verbal and physical abuse from 

children’s   hockey activities. 
 

 I will respect and show appreciation for the volunteer coaches who 
give their time to provide hockey experiences for my child. 

 
 
Parent’s Signature:  Date:  
 



FF ir aair PPl  laayy CCooddee    
                      ... for PLAYERS 

 
 

 I will play hockey because I want to, not just because others or coaches 
want me to. 

 
 I will play by the rules of hockey, and in the spirit of the game. 

 
 I will respect my opponents. 

 
 I will control my temper – fighting and mouthing off can spoil the 
activity for everyone. 

 
 I will do my best to be a true team player. 

 
 I will remember that winning isn’t everything that having fun, improving 
skills, making friends and doing my best are also important. 

 
 I will acknowledge all good plays / performances – those of my team 
and of my opponents. 

 
 I will remember that coaches and officials are there to help me. I will 
accept their decisions and show them respect. 

 
 
 
 
Parent’s Signature:  Date:  
 



Conducting the First Parent Meeting  
 

Adapted from ‘Avenue Road Ducks Novice Selects’ 
(host meeting shortly after team is formed) 

 
Scheduled Date: _____________________ 

 
 
A. Introduction (5-10 minutes) 
- Introduce yourself (manager), coach, assistant coaches, trainer, etc. 
- Give a brief explanation of the importance and purpose of the meeting. 
 
 
B. Coaching Overview (10 minutes) 
- Have the Coach provide information on the goals and objectives for the season and his 

credentials and philosophy. 
 
 
C. Details of Program / Expectations for Players (10-20 minutes) 
- With the Coach present specific information on the operation of your hockey program. 
- Overview of how coach and player evaluations will be implemented. 
- Discuss expectations of the player (and parents) Appendix 1: Fair Play Codes 

• Time commitment 
• Respect for themselves, all players (own team and opposition), referees, officials, 

parents, etc. 
• Expected conduct – games, practices, locker room, events 
• Discipline 

- Let parents participate in deciding rules of parent conduct at games, team functions, etc. 
 
 
D. Budget (15 minutes) 
- Outline of expected costs Appendix 22: Budget 
- Initiate fundraising discussions – will there be a fundraiser, or will each family make a 

contribution? Suggestions: bingos, casinos, dinners, auctions / raffles, sponsors, etc. 
- Extra activities – social events, photos, extra tournaments, how much extra ice time must 

be booked? 
 
 
E. Team Apparel (5 minutes) 
- Discuss dress code 
- Water bottle policy 
 
 
F. Expectations of the Parents / Volunteers (20 minutes) 
- Organize a parent’s committee to coordinate roles and responsibilities – volunteer roles 

are essential and each family should participate in a role. Appendix 3: Parents’ Contact 
& Responsibility List 

 
 
G. Questions (5 minutes) 
- Allow additional questions, parent concerns, etc. 
- Distribute materials and any forms that need parent’s attention. 
- Set up time for next meeting. Date: _____________________ 
 



ROLE NAME HOME PHONE E-MAIL

PARENTS' CONTACT & RESPONSIBILITY LIST
Team / Year



  

    

        

  

  

  

  

  

  

  

  

  

    

  

  

  

  

PHONE TREE OUTLINE 
  



FACILITY SAFETY CHECKLIST 
 

Name of Facility:  

Address:  

Facility Manager:  

Date of Inspection:  By Whom:  

Position:    

 
 

FINDINGS 
 

Area Good Condition 
Acceptable 

Unacceptable Notes / Comments 
 

     

Ice condition     

Breakaway nets     

Boards     

Lighting     

Benches     

Gates     

Glass enclosures     

Air quality     

Penalty boxes     

Officials’ box     

Evacuation procedure     

Emergency exits     

Emergency medical     

Telephone     

Heating system     

Other danger areas     
 
 
Report filed with:  Date:  

(e.g. branch, rink manager, etc.) 

Response Requested: Yes   No    

Action Taken:  

 



Hockey Canada

Hockey Canada Safety Program

SAFETY REQUIRES TEAMWORK
 AN EMERGENCY ACTION PLAN FOR HOCKEY

EQUIPMENT LOCATIONS
Please locate and identify areas on above map:		
i.e., first aid room, routes for ambulance crew, 
telephones, emergency exits, etc.

Arena/Facility name:  _____________________

Address:  ______________________________
	
Telephone number:  ______________________

Emergency Telephone Numbers

Emergency	  	 _________________________

Ambulance		  _________________________	

Fire Dept		  _________________________

Hospital		  _________________________

Police		  _________________________
   
General		  _________________________

Other		  _________________________

1. Charge Person

•	Most qualified person available with training in first 
aid and emergency response

•	Familiarize yourself with arena emergency equipment 
•	Take control of an emergency situation until medical 
personel arrive

•	Assess injury status of player 

2. Call Person 

•	Location of emergency telephone 
•	List of emergency telephone numbers 
•	Directions to arena 
•	Best route in and out of arena for ambulance crew 
• Communicate with Charge Person and Control Person

3. Control Person

•	Ensure proper room for Charge Person and ambulance 
crew 

•	Discuss emergency action plan with:
• Arena staff
• Officials
• Opponents

•	Ensure that the route for the ambulance crew is 
clear and available 

•	Seek highly trained medical personnel (i.e., MD, 
nurse) to assist injured player if requested by Charge 
Person

•	Discuss player’s injury and status with parents. 

Legend
	 Phone
	 Exits
	 First Aid



Hockey Canada 
Abbreviations & Acronyms 

 
Association and Branch Acronyms 
BCH British Columbia Hockey 
HA Hockey Alberta 
HC Hockey Canada 
HM Hockey Manitoba 
HN Hockey North 
HNB Hockey New Brunswick 
HNL Hockey Newfoundland and Labrador 
HNO Hockey Northwestern Ontario 
HNS Hockey Nova Scotia 
HPEI Hockey Prince Edward Island 
HQ Hockey Quebec 
IIHF International Ice Hockey Federation 
ODHA Ottawa District Hockey Association 
OHF Ontario Hockey Federation 
OWHA Ontario Women's Hockey Association 
SHA Saskatchewan Hockey Association 

 
 

Organizations and Initiatives 
ADC Athlete Development Committee 
CAAWS Canadian Association for Advancement of Women in Sport 
CAC Coaching Association of Canada 
CDM Canadian Development Model 
CHL Canadian Hockey League 
CIAU Canadian Intervarsity Athletic Union 
CIS Canadian Interuniversity Sport 
HCRC Hockey Canada Regional Centre 
HCSA Hockey Canada Skills Academy 

HDC Hockey Development Council 
ICC International Coaches' Conference 
IP Initiation Program 
LTAD Long Term Athlete Development 
MHA Minor Hockey Association 
NCCP National Coaching Certification Program 
NCMP National Coach Mentorship Program 
NHL National Hockey League 
NSST National Skills Standards and Testing 
NWT National Women's Team 
RIC Referee in Chief 



Score Sheets / Game Abbreviations 
A Assists 
C Centre 
D Defenseman 
DvP Points Scored against Teams within the Division 
EN Empty Net 
F Forward 
FL Face-offs lost 
FW Face-offs Won 
FWP Percentage of Face-offs Won 
G Goals or Goaltender 
GAA Goals Against Average 
GP Games Played 
GW Game Winning Goal 
HmP Points Scored on Home Ice 
L Losses 
LW Left-wing 
NO Player Jersey Number 
ODvP Points Scored against Teams outside the Division 
OT Overtime 
P/G Average Points Scored per Game 
PIM Penalty Minutes 
PK Penalty Kill 
POS Player Position 
PP Power Play Goal 
PPP Points Scored while on the Power Play 
PTS Points 
RdP Points Scored on the Road 
RW Right-wing 

Shooting Percentage S% 
SA Shots Against 
SH Short Handed Goal 
SHP Points Scored while Short-handed 
SO Shutouts 
SOG / S Shots on Goal 
SV / S  Saves 
SV% Save Percentage 
T Ties 
W Wins 

 



  
 

Team Name ___________________________________________ OFFICIAL ROSTER 

Division (Midget, Bantam Female, etc.) ______________________ 

 

1. The information below is collected for all registered participants and is required by 
____________________ (its employees, team officials, volunteers, leagues and associations) 
to facilitate its hockey programs and to administer the rules that govern sanctioned events. 
Signature below indicates understanding and agreement with respect to the 
aforementioned use of personal information. 
 

SAMPLE COPY ONLY  
Provincial Play-off Category (A, AA, etc.) _____________________ 
Pending verification by Zone Registrar 
(not applicable for WMHA) 

 

2. _________________ does not share the information we collect outside our Branch and 
Associations, however we may from time to time use this information for the purposes of 
offering additional services, including promotions offered by third parties. This type of usage of 
your personal information by ______________ and/or its associations is entirely at your 
discretion. Please indicate your preference by circling Yes or No next to your signature. 

 
 

NOTE: Bantam & Higher Categories, Circle Goalie Number Below 
 

_______________ treats this information with the utmost respect and in accordance with the 
_________________ Privacy Policy at all times. For further information on _______________ 
Privacy Policy, please visit our website at _______________ 

 
 SURNAME (please print) GIVEN NAME 

(please print) M/F D.O.B. 
D/M/Y 

MAILING ADDRESS / CITY (Include 
Section/Township/Range/Quarter if applicable) 

POS-
TAL 

CODE 

PHONE 
NUMB

ER 

LAST TEAM 
REGISTERED 

1. PARENT’S / 
GUARDIAN’S 
SIGNATURE 

2. Yes/No 

1.           Y  N  
2.           Y  N  
3.           Y  N  
4.           Y  N  
5.           Y  N  
6.           Y  N  
7.           Y  N  
8.           Y  N  
9.           Y  N  

10.           Y  N  
11.           Y  N  
12.           Y  N  
13.           Y  N  
14.           Y  N  
15.           Y  N  
16.           Y  N  
17.           Y  N  
18.           Y  N  
19.           Y  N  
 
Please circle Primary Contact 

  
Levels: IP = Initiation, C = Coach, I = Intermediate, A = Advanced, SO = Speak Out (formerly Coach Awareness Program), S = Safety 

 SURNAME (please print) GIVEN NAME 
(please print) M/F D.O.B. 

D/M/Y 

MAILING ADDRESS / CITY / POSTAL CODE 
(Include Section/Township/Range/Quarter if 

applicable) 

PHONE 
NO. 

(Res) 

PHONE 
NO. 

(Bus) 

CIRCLE 
CERTIFICATION 

LEVELS ATTAINED 

1. TEAM OFFICIAL’S 
SIGNATURE 2. Yes/No 

1.  Head Coach        IP C I A SO S  Y  N  
2.  Asst. Coach        IP C I A SO S  Y  N  
3.  Asst. Coach        IP C I A SO S  Y  N  
4.  Manager        IP C I A SO S  Y  N  
SAFETY – Please complete this area even if listed as a Coach or Manager            
5.  Safety        IP C I A SO S  Y  N  
 

BRANCH APPROVAL ______________________ DATE APPROVED ___________________ ASSOCIATION APPROVAL _____________________ DATE APPROVED ______________________ 
 

PLEASE SUBMIT YOUR COMPLETED ROSTER TO THE APPROPRIATE ZONE REGISTRAR 
(YOUR SIGNATURE INDICATES THAT YOU ARE AWARE OF THE COACHING CERTIFICATION REQUIREMENTS) 

 



Coach: Phone: Cell: Email:
Asst. Coach Phone: Cell: Email:
Asst. Coach Phone: Cell: Email:
Manager: Phone: Cell: Email:

First Name Last Name Address Phone # Cell # DOB 
DD/MM/YY

Guardian #1 
/ Relation

Guardian #2 
/ Relation Email Address

TEAM CONTACT LIST
Team / Year



Arena: Phone: 
Address:

Hospital: Phone:
Address:

ROLE NAME PHONE E-MAIL

ASSOCIATION CONTACT LIST
Team / Year



PLAYER MEDICAL INFORMATION SHEET 
 

Name:    
Address:    
City / Province:  Postal Code:  
Telephone: (        )   
    
Date of Birth: Day:    Month:  Year:  
Provincial Health #:    
    
Mother’s Name  Home Phone: (        ) 
  Work Phone: (        ) 
Father’s Name  Home Phone: (        ) 
  Work  Phone: (        ) 
 
Person to contact in case of accident or emergency, if parents are not available: 
Name:  Phone: (        ) 
Address:    
    
Doctor’s Name:  Phone: (        ) 
Dentist’s Name:  Phone: (        ) 
 
 
Please check the appropriate response below pertaining to your child: 
YES NO   YES NO  

  Previous history of concussions    Diabetic 

  Fainting episodes during exercise    Medication 

  Epileptic    Allergies 

  Wears glasses    Wears a medic alert bracelet or necklace 

  Are lenses shatterproof?    Surgery in the last year 

  Wears contact lenses    Has been in hospital in last year 

  Wears dental appliance    Presently injured 

  Hearing problem    Has had injuries requiring medical attention in 
the past year 

  Asthma    Has had an illness lasting more than a week in 
the past year 

  Trouble breathing during exercise    Has a health problem that would interfere with 
participation on a hockey team 

  Heart condition     

 
Please give details below if you answered “Yes” to any of the above items. Use separate sheet if necessary. 
 
 
 
 
 
 



Medications: 
 
 
 
Allergies: 
 
 
 
Medical Conditions: 
 
 
 
Recent Injuries: 
 
 
 
Last Tetanus Shot: 
 
 
 
Date of last complete physical exam: 
 
 
 
Any information not covered above: 
 
 
 
 
 
 
 
Any medical condition or injury problem should be checked by your physician before participating in a hockey 
program. 
 
I understand that it is my responsibility to keep the team management advised of any change in the above 
information as soon as possible and that in the event no one can be contacted, team management will take my child 
to hospital/M.D. if deemed necessary. 
 
I hereby authorize the physician and nursing staff to undertake examination investigation and necessary treatment of 
my child.  I also authorize release of information to appropriate people (coach, physician) as deemed necessary. 
 
Date:  Signature of Parent of Guardian:  
 





HOCKEY CANADA INJURY REPORT 

 

CLAIMS MUST BE PRESENTED WITHIN 90 DAYS OF INJURY. INJURY DATE:   _____/_____/_____

INJURED PARTICIPANT: � Player   � Team Official � Game Official � Spectator

Name: ____________________________________________________________  Birthdate: _____/_____/_____   Sex:   (M)  (F) 

Address: __________________________________________________________ City/ Town ________________________________

Province: ________________________ Postal Code: ________________________ Phone: (______) _______________________

Parent/Guardian: _______________________________________________________________________________________________

DIVISION: 
� Initiation � Novice � Atom � PeeWee
� Bantam � Midget � Juvenile

CATEGORY:
� AAA � AA � A � B � BB � C � CC
� D � DD � E � House � Major Junior � Minor Junior
� Senior � Adult Rec. � Other __________________________________________

BODY PART INJURED: * visit the Hockey Canada web-site for an optional questionnaire *
Head Back Trunk Arm � Left � Right Pelvis Leg � Left � Right
� Eye Area � Face � Neck � Ribs � Shoulder � Hand/Finger � Hip � Thigh � Foot
� Throat � Dental � Upper � Chest � Upperarm � Forearm/Wrist � Groin � Knee � Toe
� Skull � Lower � Abdomen � Elbow � Collarbone � Shin � Other
NATURE OF CONDITION:  
� Concussion � Laceration � Fracture � Sprain � Strain
� Contusion � Dislocation � Separation � Internal Organ Injury

ON-SITE CARE: � On-Site Care Only � Refused Care
� Sent to Hospital, by: � Ambulance � Car 

INJURY CONDITIONS: Name of arena/ location: ___________________________________________________________________________________

� Exhibition/Regular Season  � Playoffs/Tournament � Practice � Try-outs � Other
� Warm-up � Period #1 � Period #2: � Period #3 � Overtime # ________

� Dry Land Training � Gradual Onset � Other Sport � Other: ___________________________________

Was the injured player in the correct league and level for their age group? � Yes � No
Was this a sanctioned Hockey Canada hockey activity? � Yes � No
CAUSE OF INJURY: 
� Hit by Puck � Collision with Boards � Non-Contact Injury
� Hit by Stick � Collision on Open Ice � Collision with Opponent
� Fall on Ice � Checked From Behind � Collision with Net
� Fight � Blindsiding

LOCATION: 
� Defensive Zone � Offensive Zone � Neutral Zone
� Behind the Net � 3 ft. from boards � Spectator Area
� Parking Lot � Dressing Room � Bench
� Other: _____________________________________________________

WEARING WHEN INJURED: 
� Full Face Mask � Intra-Oral Mouth Guard
� Half Face Shield/Visor � Throat Protector
� Helmet/No Face Shield � No Helmet/No Face Shield
� Short Gloves � Long Gloves

ADDITONAL INFORMATION: 
Has the player sustained this injury before? � Yes � No

If “Yes” how long ago ________________________________

Was a penalty called as result of the incident? � Yes � No
Estimated Absence from hockey? � 1 week � 1-3 weeks � 3+ weeks

DESCRIBE HOW ACCIDENT HAPPENED: 

Signed:  ____________________________________________  Date: ____________________________
(Parent/Guardian if under 18 years of age)

 

Forms must be filled out in full or
form wi l l  be  re turned.  This  form
must  be  comple ted  for  each  case
where  an in jury  is  sus tained by  a
player, spectator or any other person
at a sanctioned hockey activity.

I hereby authorize any Health Care Facility, Phyician, Dentist or other person who has attended 
or examined me/my child, to furnish Hockey Canada any and all information with respect to any 
illness or injury, medical history, consultation, prescriptions or treatment and copies of all dental, 
hospital, and medical records. A photostatic/electronic copy of this authorization shall be 
considered as effective and valid as the original.

(Attach page if necessary) 

TEAM INFORMATION:  (To be completed by a Team Official) 
Association: ____________________________________________________ Team Name : _______________________________________________________

Team Official (Print): __________________________________________ Team Official Position: ____________________________________________

Signature: ______________________________________________________ Date: _______________________________________________________________

HEALTH INSURANCE INFORMATION:
THIS MUST BE FILLED OUT IN FULL OR FORM PROCESSING WILL BE DELAYED
Occupation: � Employed Full-time � Employed Part-time � Unemployed � Full-Time Student 
Employer (If minor, list parent’s employer): ___________________________________________________________________________

1. Do you have provincial health coverage? � Yes � No      Province: ___________________________________________

2. Do you have other insurance? � Yes � No (IF “YES”, PLEASE SUBMIT CLAIM TO YOUR PRIMARY HEALTH INSURER.)  
3. Has a claim been submitted? � Yes � No (IF “YES”, PLEASE FORWARD PRIMARY INSURER EXPLANATION OF BENEFITS) 
Make Claim Payable To: � Injured Person � Parent � Team � Other: ____________________________________

Branch 
APPROVAL 

See reverse for
mailing address



Physician: _____________________________________ Address: _____________________________________________________ Tel: (______) __________________

Name of Hospital / Clinic : _____________________________________________________ Address: ___________________________________________________

Is the injury permanent and irrecoverable?   � No    � Yes

Give details of injury (degree) : ______________________________________________________________________________________________________________

______________________________________________________________________________________________________________________________________________

Prognosis for recovery : _____________________________________________________________________________________________________________________

______________________________________________________________________________________________________________________________________________

Did any disease or previous injury contribute to the current injury?    � No    � Yes (describe): ______________________________________________

______________________________________________________________________________________________________________________________________________

Was claimant hospitalized?    � No    � Yes (give hospital name, address and date admitted): ________________________________________________

______________________________________________________________________________________________________________________________________________

Names and addresses of other physicians or surgeons, if any, who attended claimant: _________________________________________________________

______________________________________________________________________________________________________________________________________________

I certify that the above information is correct to the best of my knowledge,

Signed: ____________________________________________________________________    Date: __________________________________________________________

Nature of Injury: ________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

Date of First Attendance: __________/_________/__________

Claimant will be totally disabled: 

From: ___________________ To: ___________________

PHYSICIAN’S STATEMENT 

DENTIST’S STATEMENT Limits of coverage: $1,000 per tooth, $2,000 per accident
Treatment must be completed within 52 weeks of accident

UNIQUE NO.

LAST NAME    GIVEN NAME

___________________________________
ADDRESS              APT.

___________________________________
CITY     PROV.         POSTAL CODE

FOR DENTIST’S USE ONLY – FOR
ADDITIONAL INFORMATION, DIAGNOSIS,
PROCEDURES, OR SPECIAL
CONSIDERATION.

PHONE NO.

I UNDERSTAND THAT THE FEES LISTED IN THIS CLAIM MAY NOT BE COVERED BY OR
MAY EXCEED MY PLAN BENEFITS. I UNDERSTAND THAT I AM FINANCIALLY
RESPONSIBLE TO MY DENTIST FOR THE ENTIRE TREATMENT.

I ACKNOWLEDGE THAT THE TOTAL FEE OF $ ___________ IS ACCURATE AND HAS BEEN
CHARGED TO ME FOR SERVICES RENDERED.

I AUTHORIZE RELEASE OF THE INFORMATION CONTAINED IN THIS CLAIM FORM TO
MY INSURING COMPANY/PLAN ADMINISTRATOR.

SIGNATURE OF (PATIENT/GUARDIAN)

SIGNATURE OF SUBSCRIBER

P
A
T
I
E
N
T

D
E
N
T
I
S
T

SPEC. PATIENT’S OFFICIAL ACCOUNT NO. I HEREBY ASSIGN MY BENEFITS PAYABLE
FROM THIS CLAIM DIRECTLY TO THE NAMED
DENTIST AND AUTHORIZE PAYMENT
DIRECTLY TO HIM/HER

DUPLICATE FORM   � 

OFFICE VERIFICATION

DATE OF SERVICE
DAY / MO. / YR.

INITIAL TOOTH
CODE

TOOTH
SURFACE

DENTIST’S
FEE

LAB
CHARGE

TOTAL
CHARGE

TOTAL FEE
SUBMITTED

PROCEDURE

THIS IS AN ACCURATE STATEMENT OF SERVICES PERFORMED AND THE TOTAL FEE DUE AND PAYABLE & OE.

NOTE: All benefits subject to insurer payor status, provisions of the policy, Hockey Canada sanctioned events.

Mail completed form to:
Ontario Minor Hockey Association

25 Brodie Drive, Unit #3, Richmond Hill, ON  L4B 3K7
Phone: 905-780-6642 Fax: 905-780-0344



 
NOTES: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MONTH: ______________________________ 
 
 

Sunday Monday Tuesday Wednesday Thursday Friday Saturday 

       

       

       

       

       

 



 

 

BC Hockey 6671 Oldfield Road Saanichton BC V8M 2A1 info@bchockey.org 
www.bchockey.org Ph: 250.652.2978 Fax: 250.652.4536 

GAME REPORT
 

Type of Report Game Identification PRINT LEGIBLY 

Match Date of Game: 
Gross Place of Game: __________________________  
Game Category: 
10-Min Novice Atom Pee Wee  
 
Continuation Visiting Team: 

Home Team: 

Identification of Officials PRINT LEGIBLY 

Referee: Phone: Level: 
Linesman: Phone: Level: 
Linesman: Phone: Level: 

Details of Incident (one incident per report) PRINT LEGIBLY 

Period of Game 1 2 3 OT Time of Period _____________ 

Indicate to whom and why the penalty was assessed: (provide actual rule number) 

# of the team for rule 

# of the team for rule 

# of the team for rule 

# of the team for rule 

State what you saw happen, including relevant incidents leading up to and following the penalty (additional sheets may be 
used). Please print. 

Date Signature: 

Print Name: 

Mailing Instructions: 
All game reports along with the original score sheet MUST be mailed within 24 hours of incident. Reports are to be sent to the 
appropriate person based upon the rule violation. If in doubt, contact your local Referee In Chief or Referee Committee 
member immediately. 

Note – Complete one (1) report per incident. 

 

SAMPLE COPY ONLY 

Bantam _____ Midget Juvenile Junior Injury 



Game Check List 
 
Pre-Game 

 Ice Rented   
 Ice Paid for Cheque Number:  
 Officials booked  
 Officials fees  Cheque Number:  
 Volunteers lined up and trained  

     Game Clock:  
 Stats Sheet:  
 50/50 Tickets:  
 Concession:  
 Safety Person:  
 Other:  
 Other:  

 Dressing rooms checked and secure  
 
Notes: 
 
 
 
 
 
During Game 

 Monitor off-ice conduct of players and parents 
 Check dressing rooms 
 Check in with volunteers 

 
Notes: 
 
 
 
 
 
Post Game 

 Pay officials   
 Game Report signed by officials and both teams 
 Game score reported (24 hours) Called in by:  
 Game report submitted Submitted by:    

 Date mailed:  
 Rink left in good/clean condition   

 
Notes: 
 
 
 
 



TITLE: Form No.:
GAME DATE:     GAME LOCATION:
EVALUATED TEAM:     STATISTICIAN:
OPPOSITION:

NAME / PLAYER NO. REMARKS TOTAL

Notes such as:                     
# Power Play (PP) @            
Short Handed (SH)

1 2 3 OT

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

TOTALS
0 0 0 0 0

PERIOD

TEAM STATISTICS



SAMPLE COPY ONLY 
 

TRAVEL PERMIT FOR TOURNAMENT / EXHIBITION GAMES 
(IN CANADA ONLY) 

 
 
The (TEAM PARTICIPATING IN TOURNAMENT) _____________________________ hockey team is hereby 

Granted permission to participate in the _____________________________ tournament / exhibition, 

which has been sanctioned by the (HOST BRANCH – PROVINCE) _______________________ Hockey 

Association under the Hockey Canada Regulations. 

Tournament dates:  Start _________________________________ 

 End __________________________________ 

 
This permission has been granted with the understanding that the first obligation of the team is to their 
regular league games, no team may participate in a tournament while in Branch playoffs. 
 
Signed _________________________________________________ 
  Branch General Manager 
 
Date _________________________________________________ 
  Received by Branch Office 
 
PLESE COMPLETE THE FOLLOWING INFORMATION TO HELP US IN 
RETURNING YOUR SIGNED COPY OF YOUR TRAVEL PERMIT – 
THANK YOU 
 

CONTACT NAME: ________________________________________________________________________ 

MAILING ADDRESS:  Street/Box: _______________________________________________________ 

   City/Town: _______________________ Postal Code: ____________________ 

TELEPHONE: (Res) ___________________ (Bus) ____________________ (Fax) _____________________  

E-MAIL ADDRESS: _______________________________________________________________________ 



Instructions – Budget Sheets 
 
 
 
 
 
 
 
 
Potential Sources of Revenue and Expenses 
 

REVENUE EXPENSES 
   
Parent Dues Games / Practices 
Tournament Revenue  Officiating Fees 
Fundraisers  Rink / Ice Rentals 
Sponsors  Equipment Rentals 
Branch / Association  Travel Costs 
   
 Events / Tournaments - Away 
  Tournament Fees 
  Event Fees 
  Travel Costs 
  Meals 
  Lodging 
   
 Events / Tournaments - Home 
  Association Fees 
  Officiating Fees 
  Rink / Ice Rentals 
  Equipment Rentals 
  Prizes 
   
 General Operations 
  Meetings 
  Communications 
  Photos 
  Team Events 
  Meals 
  Extra Rentals 

 
 
With all budget sheets it is a good idea to save a copy of the original file. If a formula is altered, affecting 
the calculated outcome of a team sheet, the original will serve as a means of comparison.   
 
All sheets are created in Excel with basic formulas already inserted. The sheets are not locked and can 
be altered to fit any team, or can simply be used as ideas if a team wishes to create/use their own 
budgeting sheets. 
 
All templates are saved as part of the same file: 22b - Budget.xls. Select a worksheet by clicking on the 
corresponding tab at the bottom of the page; options: Year – Basic, Year – Breakdown, Monthly, and Trip. 
 



Budget Sheet 1: Year – Basic 
 
1. Fill in the team name by clicking on the cell with ‘Team’ and typing over it. 
 
2. Enter the ‘Period Covering’.  
 
3. Enter the ‘Start Balance’. Can be any number (it is currently set at zero). To enter a negative number, 
type the minus sign before the number (e.g. -210). In a cell, negative numbers are shown in brackets to 
distinguish them from positive numbers (e.g. $ 210.00 vs. $ (210.00)) 
 
4. Revenue: enter all revenue. 
 
The ‘Estimated’ column is for planning purposes, but is not required to be filled in for formulas to work 
properly. 
 
Amounts entered in the ‘Actual’ column will automatically add up in the ‘Total Revenue’ space.  
 
If another entry line is required, select a cell from the bottom row inside the revenue table. From the 
‘Insert’ menu select ‘Rows’. Repeat for each additional row needed. 
 
In the below example, the new row will be added to the Revenue table. 
 

 
 
5. Expenses: enter all expenses 
 
The ‘Estimated’ column is for planning purposes, but is not required to be filled in for formulas to work 
properly. 
 
Amounts entered in the ‘Actual’ column will automatically add up in the ‘Total Expenses’ space.  
 
If another entry line is required, select a cell from the bottom row inside the expenses table. From the 
‘Insert’ menu select ‘Rows’. Repeat for each additional row needed. 
 
6. End Balance: the end balance is automatically calculated from the data you entered (start balance + 
total revenue – total expenses). 



Budget Sheet 2: Year – Breakdown 
 
This sheet only alters from Budget Sheet 1: Year – Basic with regards to expenses. Various expense 
categories have already been created on this sheet to help the Team Manager better organize their 
expenses. Sub totals under each category will provide a more detailed visual of the team’s cost 
breakdown. Category titles can be changed if so desired.  
 
Steps 1 – 4: Same as Budget Sheet 1: Year – Basic. 
 
5. Expenses: enter all expenses 
 
The ‘Estimated’ column is for planning purposes, but is not required to be filled in for formulas to work 
properly. 
 
Amounts entered under the ‘Actual’ column for each category will automatically add up in the ‘Sub Totals’ 
space for that category. The ‘Sub Totals’ from each category will automatically add up in the ‘Total 
Expenses’ space. 
 
If another entry line is required, select a cell from the row directly above the Sub-total line of the category 
that you wish to add to. From the ‘Insert’ menu select ‘Rows’. Repeat for each additional row needed. 
 
In the below example, the new line will appear under the Games / Practices category. 
 

 
 
6. End Balance: the end balance is automatically calculated from the data you entered (start balance + 
total revenue – total expenses). 
 



Budget Sheet 3: Monthly 
 
This sheet works similar to the above two sheets, only it is broken down even further for those Team 
Manager’s looking for more detail. Along with breaking down the expenses into category, all revenues 
and expenses are broken down by month. 
 
The row that list the months has been frozen so that this information will always appear at the top of the 
screen as one scrolls down. To eliminate this feature, under the ‘Window’ menu, select ‘Unfreeze Panes’. 
 
Steps 1 –3: Same as Budget Sheet 1: Year – Basic. 
 
4. Revenue: enter all revenue into the correct month. One item may have an entry under multiple months. 
This would all appear within the same row. 
 
Amounts entered under each month will automatically add up in the ‘Total Revenue’ space for that month, 
with a yearly total appearing in the last column.  
 
If another entry line is required, select a cell from the line directly above the ‘Total Revenue’ line within the 
revenue table. From the ‘Insert’ menu select ‘Rows’. Repeat for each additional row needed. 
 
5. Expenses: enter all expenses 
 
Amounts entered under each month for each category will automatically add up in the ‘Sub Totals’ space 
for that month/category, with a yearly total appearing in the last column. The ‘Sub Totals’ from each 
category will automatically add up in the ‘Total Expenses’ spaces for each month, with a yearly total 
appearing in the last column. 
 
If another entry line is required, select a cell from the row directly above the Sub-totals line of the category 
that you wish to add to. From the ‘Insert’ menu select ‘Rows’. Repeat for each additional row needed. 
*Always add the entire row, even if you will only enter data under one month. 
 
In the below example, the new line will appear under the Games / Practices category. 
 

 
 
6. End Balance: the end balance is automatically calculated from the data you entered (start balance + 
total revenue – total expenses).



Budget Sheet 4 – Trip 
 
This sheet helps the Team Manager to budget and breakdown cost for a team trip. The worksheet only 
outlines the costs of the trip, not how the funds will be raised. 
 
1. Fill in the team name by clicking on the cell with ‘Team’ and typing over it. 
 
2. Enter the ‘Period Covered / Event’. 
 
3. Enter ‘Target Trip Budget’. This is the amount the team would ideally allot to this event.  
 
4. Enter costs. 
 
Cells highlighted in grey are the areas that will affect calculations. These cells are currently set to show 
no cost. (‘Cost per item’ and ‘Number Needed’ should be set at a default of 0, and ‘Time Frame’ should 
be set at a default of 1 to ensure formulas work properly.) 
 
Sub Total = cost per item x number needed 
Total = cost per item x number needed x time frame 
 
The descriptive columns under ‘Number Needed’ and ‘Time Frame’ can contain any description desired 
as this non-numerical entry will not affect formulas, but is to provide clarification for the numbers entered. 
 
Sample: 

 
 
5. Add a row. 
 
Select ‘Other 5’ from the bottom row of the table. Under the ‘Insert’ menu select ‘Rows’. A new row will be 
created above ‘Other 5’. Because there is calculations that take place within the rows, formulas will need 
to be added to the Sub Total and Total cells of this row. The formulas used in these two cells are listed 
above.  
 
6. Actual Trip Budget: the actual trip budget is automatically calculated from the data you entered (a 
sum of all the Totals). 
 



Glossary of Terms 
 
These definitions are taken from Hockey Canada's Articles, Bylaws and Regulations 
for 2006-07, section A. Definitions. The full document can be found on the Hockey Canada 
website at: http://www.hockeycanada.ca/6/7/5/4/index1.shtml. 
 
 
For the purpose of all Hockey Canada Articles, By-Laws, Regulations, Rules and Policies unless 
otherwise defined in a specific regulation, the following words, terms and expressions are defined 
as follows in alphabetical order:  
 
1. “Affiliate Player” (“AP”) - refers to those players from club teams, affiliated teams, or specially 

affiliated players when such player(s) are participating with a higher Division/category team. 
 

2. “Amateur” - An amateur hockey player is one who is not participating in organized 
professional hockey. 

 
3. “Category” - has the meaning assigned by B.4, 5 and 6. [Where the Divisions listed in B.1 

(senior, junior, juvenile, midget, bantam, peewee, atom, novice, initiation) and other Divisions 
created under B.2 (major, minor) are further divided, such subdivisions shall be known as 
categories: AAA, AA, A and B. (In Junior Male Hockey, the categories are as follows: Major 
Junior, Junior A, Junior B and Junior C.)] 

 
4. “Club” - has the meaning assigned by E.20 (a). [A club is defined as a local Minor Hockey 

Association operated and controlled by a duly elected Executive or Board of Directors, the 
members of which shall designate from among themselves, the persons referred to in E.4. 
(President; Secretary; and two (2) persons that the President and Secretary may designate 
as signing Officers for the purpose of release of a player.)] 

 
5. “Club Team” - has the meaning assigned by E.21 (b). [A team operating within a club, shall 

be known as a “Club Team”.] 
 

6. “Division” - means the classes of hockey being operated within this Association. These are as 
follows: Senior, Junior, Juvenile, Midget, Bantam, Pee Wee, Atom, Novice, Initiation and the 
Divisions created under B.2. [major, minor]. 
 

7. “Exhibition Game”- a game which is not part of the regular season, tournament, or play-off 
schedule. 

 
8. “Geographic-Subdivision” has the meaning assigned by F.6. [A geographic sub-division 

includes a city, a town, a municipality, a police village, a rural area or a zone as established 
from time to time by a Branch within its own jurisdiction.] 
 

9. “Goalkeeper(s)” and “Goaltender(s)” - means all players other than skaters. 
 

10. “Home Branch”- means where a player resided and was last registered to play Minor hockey 
prior to registering to play Junior hockey. 
 

11. “Horizontal Chain(s) of Teams” - means a group of club teams registered in a same Division 
but in different categories. 
 

12. “House League” - House League Hockey is defined as a community oriented Minor hockey 
program structured to provide development and competition at the recreational level. 
 

http://www.hockeycanada.ca/6/7/5/4/index1.shtml


13. “Minor Hockey” - only includes the following Divisions: Juvenile, Midget, Bantam, Pee Wee, 
Atom, Novice, Initiation and the Divisions created under B.2. [major, minor]. 
 

14. “Permanent Affiliate” - A player who registers on a lower category team for the express 
purpose of affiliating on a full time basis to the higher category team. 
 

15. “Player(s)” - means goaltenders and skaters. 
 

16. “Region” – means the geographic territory comprised of one (1) or more Hockey Canada 
Branches. 

a. “Atlantic Region” – means the grouping of the following Hockey Canada Branches: 
HPEI, HNS, HNB and HNL. 

b. “Ontario Region” – means the grouping of the following Hockey Canada Branches: 
ODHA, OHF, and HNO. 

c. “Pacific Region” – means the grouping of the following Hockey Canada Branches: 
Hockey Alberta, BCAHA, and Hockey North. 

d. “Quebec Region” – means the Hockey Quebec Branch.  
e. “Western Region” – means the grouping of the following Hockey Canada Branches: 

Hockey Manitoba and SHA. 
 

17. “Release” - means the unconditional discharge of a player from team or club membership. 
 

18. “Skater(s)” - means all players other than goalkeepers. 
 
19. “Team” - has the meaning assigned by E.1. [Definition of “teams” for registration purposes: a 

group of team officials, at least one of whom must be a coach, with all coaches meeting 
Branch certification and Speak Out requirements, and one of whom must be qualified in the 
Hockey Canada Safety Program (HTCP in Ontario), and a group of not less than fifteen (15) 
registered players, at least two (2) of whom must be goaltenders, who are qualified in one (1) 
Division and category under Hockey Canada regulations governing age, and other 
regulations up to the maximum number provided by Hockey Canada regulations.] 
 

20. “Team Official(s)” - means all or any of the persons involved in the management of a team or 
club, which includes: the coach; manager; safety person/trainer; equipment manager; team 
physician; President and other members of the Executive and/or Board of Directors of a team 
or club. 
 

21. “Tournament”- A schedule of games played among three (3) or more teams, which follows an 
inter-locking schedule and leads to an eventual winner. 
 

22. “Vertical Chain(s) of Teams” - means a group of club teams registered in the same category 
but in different Divisions. 

 
The above definitions are an integral part of Hockey Canada's Regulations. 
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